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Company Information
CPR Tools, Inc.
905 Industrial Blvd.
LaBelle, FL 33935
Tel: 863-674-0120
Fax: 863-674-0066
Email: info@cprtools.net
Web: www.cprtools.net
CPR Tools has been a leader in the field of data recovery for nearly three decades. In
meeting the needs of our own data recovery technicians and in our role as educators to the
industry, CPR Tools has developed tools designed to simplify and automate tasks in the data
recovery lab. Based on that experience, CPR Tools is uniquely qualified to ensure the
complete eradication of data. For that purpose, devices such as Hammer™, SCSI
Hammer™ and Sledge Hammer™ have been developed. Designed for use in the field or the
lab, PSIClone™ will provide years of consistent and reliable service.

Trademark Disclaimer
All referenced trademarks, product names and company names or logos cited herein are the
property of their respective owners. These include, but are not limited to Microsoft®,
Windows®, and Windows XP® which are registered trademarks of Microsoft Corporation in
the United States, other countries, or both.
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Limited Warranty Statement
CPR Tools, Inc. products are warranted by CPR Tools, Inc. against manufacturing defects in
material and workmanship under normal use for one (1) year from the date of purchase
from CPR Tools, Inc. or its authorized re-sellers. To receive warranty service, users must
register their products at http://www.cprtools.net/.
EXCEPT AS PROVIDED HEREIN, CPR TOOLS, INC. MAKES NO EXPRESS WARRANTIES AND
ANY IMPLIED WARRANTIES, INCLUDING THOSE OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, ARE LIMITED IN DURATION OF THE WRITTEN LIMITED
WARRANTIES CONTAINED HEREIN. EXCEPT AS PROVIDED HEREIN, CPR TOOLS, INC.
SHALL HAVE NO LIABILITY OR RESPONSIBILITY TO CUSTOMER OR ANY OTHER PERSON OR
ENTITY WITH RESPECT TO ANY LIABILITY, LOSS OR DAMAGE CAUSED DIRECTLY OR
INDIRECTLY BY USE OR PERFORMANCE OF THE PRODUCT OR ARISING OUT OF ANY
BREACH OF THIS WARRANTY, INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES
RESULTING FROM LOST OR CORRUPTED DATA, INCONVENIENCE, LOSS OF TIME,
PROPERTY, REVENUE, OR PROFIT OR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, EVEN IF CPR TOOLS, INC. HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
Some states do not allow the limitations on how long an implied warranty lasts or the
exclusion of incidental or consequential damages, so the above limitations or exclusions
may not apply to you.
In the event of a product defect during the warranty period, obtain return approval from
CPR Tools, Inc. prior to product return. CPR Tools, Inc. will, at its option, unless otherwise
provided by law: (a) correct the defect by product repair without charge for parts or labor;
(b) replace the product with one of the same or similar design. All replaced parts and
products, and products on which a refund is made, become the property of CPR Tools, Inc.
New or reconditioned products may be used in the performance of warranty service.
Repaired or replaced products are warranted for the remainder of the original warranty
period. You will be charged for repair or replacement of the product made after the
expiration of the warranty period.
This warranty does not cover: (a) damage or failure caused by or attributable to acts of
God, abuse, accident, misuse, improper or abnormal usage, failure to follow instructions,
improper installation or maintenance, alteration, lightning or other incidence of excess
voltage or current; (b) any repairs other than those provided by CPR Tools, Inc. or its
authorized representatives; (c) consumables such as fuses or batteries; (d) cosmetic
damage; (e) transportation, shipping or insurance costs; or (f) costs of product removal,
installation, set-up service adjustment or reinstallation.
This warranty gives you specific legal rights, and may also have other rights which vary
from state to state. Terms are subject to change at any time. See company policies at
www.cprtools.net for latest warranty information. Optional extended warranty coverage for
select products is available for purchase from CPR Tools, Inc.
Users may purchase extended warranties online at www.cprtools.net.
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Introduction
Congratulations on your purchase of Sledge Hammer™ from CPR Tools. Sledge Hammer™
was developed by CPR Tools’ engineers in answer to our valued customer’s data eradication
needs. Building upon the success of CPR Tools’ flagship data eradication devices, Hammer™
and SCSI Hammer™, Sledge Hammer™ provides the ability to eradicate data from up to
thirty-two (32) drives at one time.

Additional Features
In addition to the increased capacity for drives, Sledge Hammer™ supports up to UDMA 6,
which allows for data eradication at up to 6GB/minute.
Another key feature of Sledge Hammer™ is the ability to hot-swap drives when complete.
Simply put, this will increase productivity for anyone who needs to eradicate data from
many drives. As one drive completes, it may be removed and replaced by another drive
which will begin its data eradication process automatically.
All this happens while preserving the audit trails features which helped to make Hammer™
so successful.
Your purchase of Sledge Hammer™ adds value to your initial purchase of CPR Tools'
Hammer™ data eradication device. This is because Sledge Hammer™ leverages the power
of Hammer™. When Hammer™ firmware is updated to work with Sledge Hammer™, it is
transformed into the Sledge Hammer™ Control Box (SCB). This is done using the CPR Flash
utility and allows end-users to switch between using Hammer™ as a stand-alone device or
working with Sledge Hammer™ units.
At CPR Tools we truly believe that data recovery engineers are the best people to design
data eradication tools. With over twenty-five (25) years experience in the data recovery
industry, CPR Tools' staff are experts at getting data back. When we say it has been
eradicated, you can take that to the bank.
If you have any comments, questions or ideas for enhancements or additions to the
functionality of Sledge Hammer™, email (info@cprtools.net) or contact us via the contact
form at http://www.cprtools.net.
Technical support for all CPR Tools’ products is available online through our trouble ticket
system at http://tickets.cprtools.net
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Quick Start Guide
As with Hammer™, Sledge Hammer™ is a data eradication tool. To begin, users must have
a Hammer™ device. In order to use Sledge Hammer™ devices, Hammer™ must be
converted into the Sledge Hammer Control Box (SCB).

Hammer to SCB Conversion
Begin by installing the CPR Tools Utilities Suite. The most recent version of the software is
available at http://downloads.cprtools.net. Next, connect the Hammer™ to power and,
using the USB cable which shipped with Hammer™, connect to a Windows host using a USB
2.0 (or greater) port.
Launch the CPR Flash™ utility; this utility enables users to update their Hammer™ device.
CPR Flash should identify the attached Hammer™. Click the 'Program' button and navigate
upwards one folder. Double click on the 'Sledge Hammer Firmware' folder, then double click
on the 'Control Box' folder. Select the .alp file displayed there and click 'Open'. For
complete instructions on using the CPR Flash utility, please review the CPR Flash User's
Guide, available from http://downloads.cprtools.net.
Once Hammer™ has been flashed using Sledge Hammer™ Control Box (SCB) firmware, it is
ready to control up to four (4) Sledge Hammer™ devices simultaneously.
The Sledge Hammer™ Control Box (SCB) may be powered using the power supply which
shipped with Hammer™ or by utilizing the pigtail power connector shipped with Sledge
Hammer™. This connector is depicted in Figure 1.

Figure 1 - Pigtail Power Connector
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Physical Connection ‐ Sledge Hammer™ and the SCB
Begin by positioning one Sledge Hammer™ to the left of the Sledge Hammer™ Control Box
(SCB) on a surface large enough to accommodate the devices and drives to be eradicated.
The first Sledge Hammer™ will be connected to Side A of the SCB. Connect one end of a
PATA Cable to the connector on the short edge of Sledge Hammer™. Connect the other end
of the PATA Cable to the PATA port on Side A of the SCB.
If using the pigtail power connector shown in Figure 1, connect the pigtail power connector
to the barrel connector on the short edge of Sledge Hammer™; the other end of the pigtail
connector should be attached to the SCB’s Side A. Alternately, you may use the power
supply which shipped with Hammer™. Regardless of the method used to power the SCB,
each Sledge Hammer™ must be powered using the power cord provided.

Figure 2 - PATA and Power Connections between Sledge Hammer™ and the SCB
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Additional Sledge Hammer™ Devices
Up to three (3) more Sledge Hammer™ devices may be added. To connect a Sledge
Hammer™ to Side B of the SCB, attach a PATA cable to the SCB on Side B and connect the
other end to the PATA port on the short edge of a Sledge Hammer™. Once Sledge
Hammer™ devices are connected to either Side of the SCB, additional Sledge Hammer™
devices may be connected to the connected Sledge Hammer™ units using the PATA ports on
the short edge. The image below is a mock-up of four (4) Sledge Hammer™ units
connected to an SCB.

Figure 3 - Mock-up of four (4) Sledge Hammer™ units connected to one SCB (not to scale)

As previously mentioned, each Sledge Hammer™ requires its own connection to power.
Only the first Sledge Hammer™ connected to Side A of the SCB may provide power to the
SCB through the pigtail connector.

Attaching Drives to Sledge Hammer™
Once the SCB and Sledge Hammer™ units have
been connected to each other and to appropriate
power sources, we may connect drives to each of
the attached Sledge Hammer™ devices.
Sledge Hammer™ is available in PATA and SATA
varieties; each of these provides connections for up
to eight (8) drives of a single interface.

Sledge Hammer™ Note:
For those users familiar with Hammer™,
be advised that the small power
connectors used to power hard drives
will be inserted upside-down as
compared to Hammer™.

Lining the long edges of each Sledge Hammer™ are data and
power ports. Attach data and power cables to Sledge
Hammer™ for as many as eight (8) drives per Sledge
Hammer™ device.
Once drives have been connected, apply power to the Sledge
Hammer™ using the power toggle switch, depicted in Figure
4.
Next, depress and release the white POWER button on the
Sledge Hammer™ Control Box. The LCD on the SCB will
display status messages as the SCB Boots up and comes
ready.

Figure 4- Sledge Hammer™ power
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The Sledge Hammer™ Control Box Display
Upon powering the SCB, the device name and version
will be displayed on the LCD.

The SCB will then search for attached Sledge Hammer™
devices on both Sides (A and B). During the scanning
process, the status lights on each Sledge Hammer™ will
blink in unison as they are discovered.
Once discovered, ports which have drives attached will
be indicated by an illuminated green LED.

Figure 5 - Sledge Hammer™ displaying version

Figure 6 - SCB has discovered one Sledge Hammer™
device on Side A

The SCB will indicate the number of Sledge Hammer™
devices found on each side, as shown in Figure 6 and
Figure 7.
Figure 7 - SCB has determined that there are no
Sledge Hammer™ devices on Side B

When device discovery has completed, the SCB will
display ‘SLEDGEHAMMER START’, as depicted in Figure
8.

Figure 8 - SCB has finished device discovery
and is ready to begin
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Figure 9 and Figure 10 depict the menu structure displayed on the LCD of the SCB when it is
at rest and when commands are being executed, respectively.

The SCB Menu Structure – Part 1
|========================
|START
|========================
|OPERATIONS
|--------ERASE DRIVE
|--------|-----BANG
|--------|-----SECURITY ERASE*
|--------|-----3 PASS 1
|--------CLEAR HPA/DCO*
|--------|-----ENABLED*
|--------|-----DISABLED
|--------VERIFY
|--------|-----ENABLED
|--------|-----DISABLED*
|========================
|IDENTIFY DRIVE
|--------SLDGHMR A 1 (_/*) 2
|--------|-----DRIVE 1 (_/*) 3
|--------|----…
|--------|-----DRIVE 8 (_/*)
|--------SLDGHMR A 2 (_/*)
|--------|-----DRIVE 1 (_/*)
|--------|----…
|--------|-----DRIVE 8 (_/*)
|--------SLDGHMR B 1 (_/*)
|--------|-----DRIVE 1 (_/*)
|--------|----…
|--------|-----DRIVE 8 (_/*)
|--------SLDGHMR B 2 (_/*)
|--------|-----DRIVE 1 (_/*)
|--------|----…
|--------|-----DRIVE 8 (_/*)
|========================
|SCAN FOR DRIVES
|--------SLDGHMR A 1 (_/*)
|--------|-----DRIVES PRESENT (_/*)
NO DRIVES PRESENT
|--------SLDGHMR A 2 (_/*)
|--------|-----DRIVES PRESENT (_/*)
NO DRIVES PRESENT
|--------SLDGHMR B 1 (_/*)
|--------|-----DRIVES PRESENT (_/*)
NO DRIVES PRESENT
|--------SLDGHMR B 2 (_/*)
|--------|-----DRIVES PRESENT (_/*)
NO DRIVES PRESENT

|========================
|SETTINGS
|--------TRANSFER RATE
|--------|-----AUTO*
|--------|-----UDMA 5
|--------|-----UDMA 4
|--------|-----UDMA 3
|--------|-----UDMA 2
|--------|-----UDMA 1
|--------|-----UDMA 0
|--------|-----PIO
|--------POWER ON TIMEOUT
|--------|-----POWER ON TIMEOUT
|--------|-----|--<SELECT TIME IN MS>
|--------COMMAND TIMEOUT
|--------|-----TIMEOUT COUNT
|--------|-----|--<SELECT TIME IN MS>
|--------CLOCK/CALENDAR
|--------SAVE LOG TO DISK
|--------|-----ENABLED
|--------|-----DISABLED*
|--------SECURE PASSWORD
|--------|-----ENABLED
|--------|-----DISABLED*
|--------SESSION NUMBER
|--------|-----DISPLAY SESSION
|--------|-----RESET SESSION
|--------RESTORE DEFAULTS
|========================

Figure 9 - SCB menu structure when device is at rest

1

®

This implementation of 3Pass ‘Bang’ is customized to the specifications of, and for use by Canon
The LCD will display an underscore character (_) if no Sledge Hammer™ is detected on a given port; if a Sledge
Hammer™ is detected, an asterisk (*) will be displayed
3
The LCD will display an underscore character (_) if no drive is detected on a given port; if a drive is detected, an
asterisk (*) will be displayed
2
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The SCB Menu Structure – Part 2
|========================
|ACTIVE: XX 4
|DONE: XX
|========================
|PORTS AVAILABLE 5
|FOR HOT SWAPPING
|--------SLDGHMR A 1 (_/*)
SLDGHMR PRESENT
|--------|-----DRIVE X 6 _
AVAILABLE
DRIVE X * / OCCUPIED
|--------|-----|--START PORT X?
YES ->
|--------|-----START A 1 PORTS?5
YES ->
|--------NO SLDGHMR FOUND
|========================
|--------SLDGHMR A 2 (_/*)
SLDGHMR PRESENT
|--------|-----DRIVE X_
AVAILABLE
DRIVE X * / OCCUPIED
|--------|-----|--START PORT X?
YES ->
|--------|-----START A 2 PORTS?5
YES ->
|--------NO SLDGHMR FOUND
|========================
|--------SLDGHMR B 1 (_/*)
SLDGHMR PRESENT
|--------|-----DRIVE X_
AVAILABLE
DRIVE X * / OCCUPIED
|--------|-----|--START PORT X?
YES ->
|--------|-----START B 1 PORTS?5
YES ->
|--------NO SLDGHMR FOUND
|========================
|--------SLDGHMR B 2 (_/*)
SLDGHMR PRESENT
|--------|-----DRIVE X_
AVAILABLE
DRIVE X * / OCCUPIED
|--------|-----|--START PORT X?
YES ->
|--------|-----START B 2 PORTS?5
YES ->
|--------NO SLDGHMR FOUND
Figure 10 - SCB menu structure when a command is active

4

XX represents a two (2) digit number ranging from 00 to 32 and relates to the number of drives either active or
completed on all attached Sledge Hammer™ devices
5
This option becomes available when at least one (1) drive has completed its data eradication process
6
X represents a single digit number ranging from 1 to 8 and relates to a specific drive port on a given Sledge
Hammer™ . Each port may be accessed by tapping the UP or DOWN navigation buttons, effectively scrolling
through all available ports.
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Interacting with the SCB using the Navigation Buttons
Basics
As with Hammer™, PSIClone™ and SCSI Hammer™, the SCB makes use of four navigation
buttons: UP, DOWN, LEFT and RIGHT. Users may interact directly with the SCB to instruct
it to perform actions or cancel running actions. Typically, the RIGHT navigation button is
used to advance more deeply into a nested menu structure or to accept a prompt (similar to
pressing ‘Enter’).
Unlike other CPR Tools’ devices, the LEFT navigation button is not used to cancel a running
command. Commands may be cancelled on a port-by-port basis. To cancel a running
command, navigate through the menu structure shown in Figure 10 to appropriate port and
depress the DOWN navigation button. This
will cause the SCB to display the current LBA
being addressed. Next, press the RIGHT
navigation button and SCB will prompt to
cancel the active command on that port.
Figure 11 - SCB prompts to cancel a running command

This is depicted in Figure 11.
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Example: Power On Timeout
The following example is presented to illustrate entering and confirming a Hammer™ value.
The example uses the SCB ‘Power on Timeout’ setting; these techniques may be used for
any item which permits user entry of a value.
Where <SELECT TIME IN MS> is shown below, the user may select a value using the
navigation buttons as described in the example titled “Power on Timeout”.
Once a menu option is desired, use the RIGHT navigation button to select the option. Some
menu options may have submenus. Once the user is faced with the final selection of a menu
traversal, the RIGHT navigation button is used again to select and execute the function.
When interacting with a Hammer™ menu which requires you to select a numeric or
hexadecimal value, remember to use the RIGHT navigation button to move to the rightmost
position so that any choices will be accepted by Hammer™. When Hammer™ accepts a
value it will display ‘Configured’ on the LCD to confirm.
‘Power on Timeout’ is part of the ‘Settings’ menu tree.
|========================
|SETTINGS
|--------TRANSFER RATE
|--------|-----AUTO*
|--------|-----UDMA 5
|--------|-----UDMA 4
|--------|-----UDMA 3
|--------|-----UDMA 2
|--------|-----UDMA 1
|--------|-----UDMA 0
|--------|-----PIO
|--------POWER ON TIMEOUT
|--------|-----POWER ON TIMEOUT
|--------|-----|--<SELECT TIME IN MS>
|--------COMMAND TIMEOUT
|--------|-----TIMEOUT COUNT
|--------|-----|--<SELECT TIME IN MS>
|--------CLOCK/CALENDAR
|--------SAVE LOG TO DISK
|--------|-----ENABLED
|--------|-----DISABLED*
|--------SECURE PASSWORD
|--------|-----ENABLED
|--------|-----DISABLED*
|--------SESSION NUMBER
|--------|-----DISPLAY SESSION
|--------|-----RESET SESSION
|--------RESTORE DEFAULTS
|========================
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Sledge Hammer™ Drive Ports
Each Sledge Hammer™ device is capable of working with eight (8) drives at once. Drives
are connected to data and power ports along the long edges of Sledge Hammer™.
Figure 12 is a block drawing of the layout of Sledge Hammer™ ports. The ‘green’ light at
the left of the image represents the power indicator. The layout of the Sledge Hammer™
ports in
Figure 12 represents a Sledge Hammer™ connected to Side A of an SCB.

Figure 12 - Sledge Hammer™ drive ports

There are four (4) LED indicators on the top face of Sledge Hammer™ to assist in
determining what action is taking place at that port at any given time. Considering the
layout above, the LED colors would be displayed from left to right on ports 5 through 8:
•
•

•
•

Green
 Power to the port is ON if this LED is illuminated
Blue
 When a port is in ‘focus’, the BLUE LED will be illuminated
 Focus is achieved by using the SCB’s navigation buttons during a command. As
an example, when scrolling through available ports for hot-swapping, ports noted
on the LCD will illuminate BLUE.
Red
 An error has occurred
Yellow
 This LED will be blinking when a command is active on its associated port.
 This LED will be solid when a command has completed

It is possible that a command may complete with errors, in which case the RED and
YELLOW LEDs will be illuminated solid.
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Hot‐ Swapping Drives
One of the most exciting, and most requested features built into Sledge Hammer™ is the
ability to hot-swap drives once a port has completed its eradication pass(es).
When the SCB indicates that any drives are ‘Done’, users may use the navigation buttons to
determine which port is available for hot-swapping.
When an action is being performed, the SCB will display the number of drives ‘active’ as
well as the number of drives ‘done’.

A typical ‘Bang’ on 3 drives
This example will make use of an SCB to which one Sledge Hammer™ is connected on Side
A. Three (3) drives are connected to the Sledge Hammer™.
When the SCB is powered, it will scan for
attached Sledge Hammer™ devices and
drives. Once the scan has completed,
SLEDGE HAMMER START is displayed.

Pressing the RIGHT navigation button will
instruct SCB to prompt for confirmation
before beginning the eradication process
on ALL attached drives. This example
uses ‘Bang’.
Press the RIGHT navigation button to
confirm and begin the eradication process.
The SCB will display INITIALIZING

When the eradication process begins, the
SCB will display the number of ‘active’ and
‘done’ drives

As drives complete, the display is updated
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Once any drive has completed, users may
depress the DOWN navigation button to
reach the Hot-Swap menu structure

Depressing the RIGHT navigation button
will allow the user to select an attached
Sledge Hammer™. (The asterisk shown
indicates that the attached Sledge
Hammer™ is in use)
Pressing the RIGHT navigation button
allows the user to scroll through all drive
ports on the selected Sledge Hammer™.
As we scroll through, using the UP and
DOWN navigation buttons, Sledge
Hammer™ will illuminate the BLUE LED for
the selected port.
Users may swap out drives on ‘Available’
ports

Once a drive has been swapped, the
individual port may be started by pressing
the RIGHT navigation button

Alternately, by scrolling through all ports
using the DOWN navigation button, users
may start all available ports on the Sledge
Hammer™ at once.
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Software:
CPR Tools Utilities Suite
The CPR Tools Utilities Suite is a collection of software designed to work with Hammer™,
PSIClone™, SCSI Hammer™, Sledge Hammer™ and other CPR Tools devices. The CPR
Tools Utilities Suite includes:
1. CPR Toolbox™
• Host utility
2. CPR Tools Flash Utility + USB Driver
• Software to update firmware
• CPR Tools USB Driver
3. Firmware
• Latest firmware
4. Documentation
• Release Notes
• User Guides
• Specification Sheets

NOTE:

When available, updates to software,
firmware and documentation may be
downloaded from
http://www.cprtools.net/downloads.

The next section of this guide will review installation of the CPR Tools Utilities Suite and use
of the host companion software, CPR Toolbox™
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Working with a Windows XP®, Windows Vista® or
Windows 7®

NOTE:
CPR Tools host utilities interact
with Sledge Hammer™ via
USB 2.0 connections only.

The CPR Utilities Suite is a collection of applications designed
to run on Microsoft® Windows XP® SP2, Windows Vista® and
Windows 7® Operating Systems. Sledge Hammer™ and the
SCB may be connected to a host computer by USB, using the
cable provided. CPR Toolbox™ extends functionality and provides a familiar user interface
with which Sledge Hammer™ and the SCB may be used.

Installing CPR Utilities Suite
The CPR Tools Utilities Suite is included on the CD which was shipped with Sledge
Hammer™. Install the software by inserting the CD into
NOTE:
the host system. The CPR Tools Utilities Suite installer is
The latest updates for the CPR Tools
packaged as a self-extracting archive.
Utilities Suite including CPR Toolbox™
are always available at the CPR Tools
Double click the file ‘CPR Tools Utilities Suite.EXE’ to
download page:
begin the installation process. The install process is
http://www.cprtools.net/downloads.
guided by the CPR Tools Utilities Suite Setup Wizard.

Figure 13 - CPR Tools Utilities Suite Setup Wizard

Click ‘Next’ to continue.
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The ‘License Agreement’ screen which follows, is shown in Figure 14.

Figure 14 - CPR Tools Utilities Suite License Agreement

The destination of the installation is user configurable. Users may select the default location
or specify a path on the host.

Figure 15 - Select Destination Location
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By default, the program will install to the system drive (typically ‘C:’) under ‘Program
Files\CPR Tools\CPR Tools Utilities Suite’. To install to the default location, click ‘Next’.
Users may select a complete installation or customize the installation of CPR Tools Utilities
Suite. Figure 16 depicts the ‘Select Components’ dialog box which allows for customizing
the installation of components.
In this view, ‘Full Installation’ is selected and shown in the drop-down list at the top of the
dialog box. Users may deselect any undesired components by clicking the checkbox beside
the listed component. ‘Full Installation’ includes firmware and documentation for
PSIClone™, Hammer™ and SCSI Hammer™ and Sledge Hammer™ .
Users may choose to install only files relating to Sledge Hammer™ by selecting ‘Sledge
Hammer Installation’ from the drop-down list provided.

Figure 16 - Full Installation – All items are installed.

After selecting desired components, click ‘Next’.
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The ‘Select Additional Tasks’ dialog is presented which offers users the ability to create
Desktop and Quick Launch shortcuts for selected components. Items marked with a
checkmark will generate Desktop and Quick Launch icons; deselect any item for which
neither Desktop nor Quick Launch icons are desired.

Figure 17 – Select Additional Tasks

Click ‘Next’.
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The ‘Ready to Install’ dialog box is presented to confirm all selected components. To
change which components are to be installed, click ‘Back’.

Figure 18 - Ready To Install

To proceed with installing the selected components, click ‘Install’.
Installation progress is provided as shown in Figure 19.

Figure 19 - Installation progress
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The default settings for the installer include installation of the CPR Flash™ utility which is
used to update the firmware for Hammer™ and CPR Toolbox™ which is the host companion
software for PSIClone™, Hammer™ and SCSI Hammer™. This will cause the ‘Windows Logo
Testing’ dialog box to appear.

Figure 20 - Windows Logo Testing dialog box.
Click 'Continue Anyway' if this is shown.

Users must click ‘Continue Anyway’ for the required USB driver to be installed.
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The default installation options include files which work with CPR Tools’ PSIClone™ data
recovery device. If the default options are used, the installer will install driver support for
CPR Tools’ SeaKey. This is shown below in Figure 21.

Figure 21 - Installing SeaKey™ support
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When the installer has completed, a confirmation message is displayed.

Figure 22 - Installation Complete

To exit the installer, click ‘Finish’. If the ‘Launch CPR Toolbox 2010’ box is checked, CPR
Toolbox™ will launch; if the ‘Browse Documentation’ box is checked, a Windows Explorer
window will open to the folder into which documentation was installed. The documentation
subfolder contains useful information, including Release Notes, Spec Sheets and User
Guides.
The Release Notes folder provides helpful information about Hammer™ as well as the
applications installed by CPR Tools Utilities Suite installer, including CPR Flash™ and CPR
Toolbox™.
The Spec Sheets folder includes product specifications for Hammer™, Sledge Hammer™,
SCSI Hammer™ and PSIClone™.
The User Guides folder contains PDF versions of user guides for Hammer™, Sledge
Hammer™, SCSI Hammer™ and PSIClone™.
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Launching CPR Toolbox 2010™
If CPR Toolbox™ was installed using default installer settings, the program may be launched
from the Windows Start menu, under Programs/CPR Tools/CPR Toolbox 2010. The
application will discover any CPR Tools’ devices (PSIClone™, Hammer™, etc…) which are
powered and connected to the host system. The image below shows the initial screen when
CPR Toolbox™ is launched with a Hammer™ powered and attached to the host PC.

Figure 23 - CPR Toolbox™, Initial Screen

CPR Toolbox™ 2010 displays three main panes of information, a toolbar and typical
Windows pull-down menus.
The vertical pane at the left of the screen (Labeled ‘A’) lists CPR Tools’ devices and
drives attached to CPR Tools’ devices.
The pane at the right of the screen (Labeled ‘B’) is the main display window. This
will be populated, in tabbed format, as toolbar items are clicked.
The lower, horizontal pane (Labeled ‘C’) displays output; i.e. logs, success/fail
information, etc…
The pull-down menu structure within CPR Toolbox™ is:
File
Save Log
Print Log
Find in Log
Close
Exit

Edit
Preferences
Sync Device
Time

View
Toolbars and Docking
Windows
Standard*
Drive List*
Status Bar*
(* on by default)

Help
PSIClone Help
Hammer Help
SCSI Hammer Help
Sledge Hammer Help
Debug Registers
Generate Tech
Report
About CPR Toolbox
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The ‘File’ menu:

Clicking the ‘File’ menu reveals options displayed above. ‘Save Log’, ‘Print Log’, ‘Find in
Log’, ‘Close’ and ‘Exit’ are presented as options.
‘Save Log’ will save the output log to a file. The user will be prompted for a location in
which to save the file. Alternately, the key combination CNTL-S may be used to save the
log to a file.
‘Print Log’ will print the output log. Alternately, the key combination CNTL-P may be used
to print the log.
‘Find in Log’ will present a search box. Using this tool, users may search for a particular
string in the active log (displayed in the bottom, horizontal pane, labeled ‘C’ in Figure 23.
‘Close’ becomes available when CPR Toolbox is displaying one or more tabs within its main
window. Clicking ‘Close’ will close the current tab.
Clicking ‘Exit’ will close CPR Toolbox.
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The ‘Edit’ Menu:

The first option under the ‘Edit’ menu is ‘Preferences’. Selecting ‘Preferences’ will instruct
CPR Toolbox™ to present the Preferences editor, shown in Figure 24.

Figure 24 - General Preferences
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The Preferences box is divided into two (2)
sections labeled General and Power Settings.
General
This section contains options which define how
CPR Toolbox™ will behave upon being launched.
By clicking on each line in turn, a dropdown box
will appear for the value at right.
Perform initial device scan
By default, CPR Toolbox™ will perform a scan for
devices. This may be changed selecting ‘No’ from
the available dropdown box.
Append to activity log
By default, activity logs will be overwritten. To
change this behavior, set this value to ‘Yes’
Auto-launch control panel
By default, CPR Toolbox will launch the ‘Control
Panel’ whenever a device is selected. Set this to
‘No’ to alter this behavior.

Figure 25 - General Preferences

Port Protect
By default, no ports are protected from initial scans; CPR Toolbox™ will attempt to identify
all attached drives when a CPR Tools device is
powered. This setting allows for customization of
this behavior. Available options are ‘Side A’,
‘Side B’, ‘Both’ or ‘None’.
Power Settings
Note:
The ‘Power Settings’ section
is not used when using CPR
Toolbox™ with Sledge
Hammer™

Figure 26 - Power Setting Preferences

905 Industrial Blvd • LaBelle, FL 33935 • Tel: 863‐674‐0120 • Fax: 863‐674‐0066 • www.cprtools.net • info@cprtools.net
SledgeHammer™ User’s Guide
Page 31 of 62

The ‘View’ Menu:

The ‘View’ menu provides the ability to select or deselect areas of the CPR Toolbox™ from
being displayed.
Expanding the item labeled ‘Toolbars and Docking Windows’ provides the user the ability to
toggle viewing of the Standard toolbar, shown in Figure 27, the Output pane and the Drive
List pane.

Figure 27 - CPR Toolbox Standard Toolbar

The Output pane and Drive List pane are shown in Figure 28, labeled C and A respectively.

Figure 28 - CPR Toolbox

The Status bar, an informational display located at the very bottom of the main CPR
Toolbox™ window, may be toggled on and off by selecting or deselecting it in the ‘View’
menu.
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The ‘Help’ Menu:

Online help is available from within this menu by clicking ‘Help’. The remaining options and
their functions are:
PSIClone™ / Hammer™ / SCSI Hammer™ / Sledge Hammer™ Help
CPR Toolbox™ provides help files for PSIClone™, Hammer™, SCSI Hammer™ and Sledge
Hammer™ devices.
Debug Registers
This option will open a ‘tab’ which displays debug registers for the selected device. Use this
when instructed to by CPR Tools technical support personnel.
Generate Tech Report
This option will save technical information to a text file of the user’s choosing and should be
utilized when instructed to by CPR Tools technical support personnel.
About CPR Toolbox
This option displays version information for CPR Toolbox™ and its components.
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The CPR Toolbox™ Standard Toolbar
The CPR Toolbox™ software is easily controlled through the convenient button bar at the
top of the main Toolbox window. The toolbar is depicted in Figure 29.

Figure 29 - The CPR Toolbox™ button bar

The button bar displays ten (10) buttons, some of which have submenu selections available.
The button bar menu structure is displayed here:
•
•
•

•

•

•
•
•
•
•

Rescan
Control Panel
Drive Info
o Identify Drive7
o View S.M.A.R.T.7
Drive Utilis
o Sector Viewer 7
o eDrive™ 8
o gClone™8
o gRase™
Recovery
o Image Restore
o Advanced Recovery8
o iFirmware8
o Mount Image8
o Recover My Files8
o Mount/Unmount Drive8
Security
o Drive Key8
Reporting
Save
Print
About

If an item selected is not supported by Hammer™, CPR
Toolbox will display a message indicating that the selected
option requires a device other than Hammer™.

7
8

Not supported by Sledge Hammer™
Not supported by Hammer™, Sledge Hammer™ or SCSI Hammer™
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Rescan
Clicking this toolbar button will cause the CPR Toolbox™ to rescan for CPR Tools devices
(e.g. PSIClone™, Hammer™, Sledge Hammer™, SCSI Hammer™, etc…).

Control Panel
Clicking this toolbar button will launch the Control Panel module. The CPR Toolbox™
Control Panel module provides a graphical interface for working with and controlling Sledge
Hammer™ and the SCB.
Figure 30 presents the Control Panel with one SCB attached to a single Sledge Hammer™.
In this example, there are six (6) drives attached to the Sledge Hammer™.
Users may note that the vertical pane at left shows the SCB, the attached Sledge Hammer™
and the six (6) drives. The Sledge Hammer™ is directly attached to Side A of the SCB and
so is labeled Sledge Hammer™ A1. An SCB can accommodate up to four (4) Sledge
Hammer™ devices. If additional Sledge Hammer™ devices were to be attached to the
SCB, they would be labeled A2, B1 and B2.

Figure 30 - Control Panel showing an SCB connected to a single Sledge Hammer
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Device Settings
Resting between the right vertical pane and the control panel window lies a tab labeled
Device Settings. By hovering the mouse over this tab, the Device Settings pane will 'fly
out'. This pane is used to establish custom device settings or to restore factory defaults.
As with many tabbed/paned software products, this pane may be 'pinned' to the screen by
clicking the thumbtack icon
Default settings for Sledge Hammer™ are:
•
•
•
•
•

Security Erase
Clear HPA/DCO
Transfer Rate - Auto
Command Timeout: 4,000 ms
Power On Timeout: 20,000 ms

These are shown in Figure 31.

Figure 31 - Sledge Hammer™ Default
Settings
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Figure 32 more clearly identifies the Control Panel screen showing display areas for as many
as four (4) Sledge Hammer™ devices and drives attached to them.

Figure 32 - Control Panel provides display areas for as many as four (4) Sledge Hammer™ devices

Figure 33 shows the attached Sledge Hammer™ and drives in detail. Note the buttons
along the left edge of the display. The topmost button provides a method for users to
rescan all ports on a given Sledge Hammer™. Each of the subsequent eight (8) buttons
allow for direct control of the eight (8) individual drive ports.

Figure 33 - Direct drive port control is provided

Users will note that for ports where no drive is shown, the control button at left is labeled
'Scan Port X' where X represents the drive port number. For those ports where a drive is
listed, the control button is labeled 'Start'. Were there active processes running, the control
button will change to read 'Cancel' for any active drives.
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Reporting
Clicking the Reporting toolbar button will cause CPR Toolbox to open the Reporting module.
The Reporting module consists of five (5) tabs. These are:
•
•
•
•
•

Jobs
Certificates
Print Labels
Device Log
Alert Settings

Selecting a Device
At the top of the reporting module,
users will find a drop-down menu
which allows for:
•
•

The selection of an attached
device
The user to manually enter a
device which is not connected
for which Alerts may be
customized

Customizing alert settings is discussed
in the section titled The “Alert
Settings” Tab – CPR Toolbox™ , on
page 52.
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Audit Trails and Certificates of Compliance
One of the key features behind the success of CPR Tools’ data eradication devices is the
ability to keep strict audit trails and produce Certificates of Compliance for drives upon
which data eradication has been performed. Proper audit trails help organizations maintain
compliance with regulatory and statutory rules for data privacy.
Data eradication logs are stored, by default, on the Sledge Hammer™ device. Using this
default setting, large numbers of drives can be subjected to data eradication and accurate
reporting can be extracted from the device using the host companion software, CPR
Toolbox.
While CPR Toolbox does provide a wealth of other features, this portion of the guide will
focus on the extraction and organization of Sledge Hammer™ audit trails and the production
of Certificates of Compliance.
Prior to working with downloading task data from the Sledge Hammer™ and generating
Certificates of Compliance, the CPR Tools ‘Jobs’ paradigm should be discussed.
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Hammer™ and Sledge Hammer™ ‘Jobs’
An Organizing Method For Audit Trails
Hammer™ keeps track of actions
performed. These are stored on the
device in built-in Flash Memory. Each
time Hammer™ performs an action, a
history of that action is stored; each
action is associated with a Hammer™
generated sequence number. Each of
these actions is stored as a ‘Session’ in
the device’s internal memory.
If Hammer™ is used to perform an
erasure on a single attached drive, the
entry in Flash will reflect that action,
associated with the single attached drive.
If Hammer™ is used to perform an
erasure on more drives (up to four, one
per port provided), the entry in Flash will
reflect that action, associated with each
of the drives attached.

Why use Jobs to organize audit trails?
Example 1:

A technician travels to different clients to
eradicate data.
Logs from actions taken at the
client location may be grouped
into a Job specific to the client.
Example 2:

A technical support depot eradicates data
from many drives daily.
Each day’s work can be
organized into a Job named for
the date on which the erasures
were performed.

These activity logs are stored without regard for how Hammer™ is used, e.g. Stand-alone
mode, or in conjunction with CPR Toolbox™.
Once Hammer™ has performed actions, CPR Toolbox™ provides a way to organize these
logs into ‘jobs’ which may be associated with a user-friendly name, such as a client name or
location at which the tasks were performed.
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The “Jobs” Tab – CPR Toolbox™ Reporting
The ‘Jobs’ tab allows users to organize actions performed into groups of actions, called
‘Jobs’.

Figure 34 - Jobs Tab - Initial View

To begin with an attached Hammer™,
select the device from the device
selection drop-down list.
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If Sledge Hammer™
has activities stored in
Flash Memory, clicking
the Download Tasks
button will cause
Sledge Hammer™ to
display a ‘Tasks ready
for download’ dialog
box. Users may choose
to download tasks into
a ‘Job’ or to leave them unassigned.
To download tasks without assigning them to a job, simply click the button labeled
‘Download’. To assign tasks to a job, select the radio button labeled ‘Assign tasks to the
following job’, select a job from the drop-down list, then click the button labeled ‘Download’.
CPR Toolbox displays a message indicating how
many tasks were successfully downloaded and
indicates that these were not assigned.
Once tasks have been downloaded, CPR Toolbox
will present the opportunity to clear the device’s
internal operations log. Select Yes to clear the log;
select No to instruct Hammer™ to retain the log.
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To view downloaded tasks, select the appropriate ‘Task Source’ from the drop down menu.
All existing ‘Jobs’ are listed in this drop-down list. Unassigned tasks may be viewed by
selecting ‘unassigned’ from the drop-down list.

Figure 35 - Downloaded tasks are not currently assigned to a 'Job'
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Users may assign tasks to an existing job by using the drop-down list provided. First, select
the tasks to be assigned, then select the appropriate job from the list. Once selected, click
the button labeled ‘Assign To”.

Figure 36 - Assigning tasks to an existing job

CPR Toolbox provides a mechanism for making task selections based on predefined criteria.
Right-click in the jobs list to reveal a
context menu which includes the following
select filters:
•
•
•
•
•
•
•
•
•
•
•
•

Select All
Deselect All
Invert Selection
Select all ‘Hammer’
Select all ‘SCSI Hammer’
Select all ‘Pass’
Select all ‘Fail’
Select all ‘Cancel’
Select all ‘Bang’
Select all ‘Sec Erase’
Select all ‘Clone’
Select all ‘Verify’
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To create a Job, simply type the new job name in the
text box labeled ‘Enter Job Name’, then click the
button labeled ‘Create’.

Hammer™ Tips:
The default location for user created Jobs is:
C:\Documents and Settings\<user>\My Documents\CPR Tools Utilities Suite\Jobs

Each job created will be a folder under this location.

A job report may be generated for any existing job or for tasks which remain unassigned.
Select the appropriate entry from the drop-down list provided, then click the button labeled
‘Generate’.

Figure 37 - A Job Report
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The Job Report window provides the facility to Save or Print
the current report. Clicking the button labeled ‘Save’ will
cause CPR Toolbox to present a ‘Save Job’ dialog box in
which the user may select from three (3) available file
formats: Plain Text (.txt), Comma Separated Values (.csv)
or eXtensible Markup Language (.xml).

Sledge Hammer™ Tips:
Saved Jobs may be selected on the
Cert Tab to produce a series of
Certificates of Compliance after the
fact. This is an important audit
trail feature of Hammer™ and
Sledge Hammer™ .

Figure 38 - Saving a job as a file
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The “Certificates” Tab – CPR Toolbox™ Reporting

Figure 39 - Cert Tab

The ‘Cert’ tab provides an interface through which a ‘Certificate of Compliance’ may be
printed to document erasure actions performed by Hammer™. Certificates generated by
CPR Toolbox™ and Hammer™ listed here fully comply with recommendations specified in
NIST 800-88.
Sources for Certificates of Compliance
Begin by selecting the source data for the certificate to be generated. This is done in the
‘Cert Data Source’ section which presents three options, ‘Attached Drives’, ‘Hammer
Memory’ or ‘From File’. Selecting ‘Hammer Memory’ will instruct Hammer™ to use the last
action stored in NVRAM as a source for the certificate to be generated. Selecting ‘Attached
Drives’ will instruct Hammer™ to read log data which was previously stored on each
attached drive. Selecting ‘From File’ will enable the selection box and ‘Browse’ button. This
allows the user to print specific tasks from ‘job’ (.tsk) files, located in the Job folder.
To generate a Certificate of Compliance, click the ‘Generate’ button. Users may choose to
complete the available form fields which help in identifying the person(s) involved in the
erasure of data from drives attached to Hammer™. Figure 40 depicts the ‘Cert’ tab with
form fields completed.
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Figure 40 - Cert Tab - Form fields completed in preparation of generating a Certificate of Compliance.

A sample Certificate of Compliance is shown in Figure 41. Each generated certificate may
list up to four (4) drives upon which Hammer™ has
taken action.
Sledge Hammer™ Tips:

Alternate data sources for Certificates
Sledge Hammer™ and the SCB have the ability, when
working with CPR Toolbox, to provide alternate data
sources from which Certificates of Compliance may be
generated. These are:

Fully completing the form fields
prior to generating a Certificate
of Compliance ensure certifiers
will meet guidelines established
by NIST 800-88.

Device Memory
Task File
Sledge Hammer™ stores task data in on-board memory. The Certificates tab of the CPR
Toolbox Reporting module allows the selection of Device Memory as source for Certificate
generation.
Once downloaded from the device to the host, this data can be saved to a ‘task file’ which
may be opened from within CPR Toolbox for display or as a source for Certificates of
Compliance.
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Certificate of Compliance
NIST-800-88

Certificate
Number:

100174_1208081036

Date:

Device ID:

100174

Revision: v4.00:5B2D

Organization:

IT Department

Performed By:

Technician Dan

Dec 08, 2008 Time: 10:36 AM

Phone:

555 5555

Location:

Backup Storage Server, partition
1

Signature:
Issued To:

Anycompany, Inc.

Data Backed Up: Yes
Final Disposition
Redeployed Internally
of Media:

Additional Notes: This drive originated in the Accounts Payable Department

Drives annotated with PURGE have been erased with a Hammer™ SECURITY ERASE COMMAND which
complies with NIST-800-88 data "PURGING" guidelines, the strictest erasure method defined by NIST.
Drives annotated with CLEAR have been erased with a Hammer™ ERASE COMMAND which complies with NIST800-88 data "CLEARING" guidelines.
Model

Serial Number

Method Result Verification Checksum

ST310215A

3HG032AF

CLEARED PASS

N/A

N/A

ST310215A

3HG032D2

CLEARED PASS

N/A

N/A

ST310215A

3HG048D4

PURGED

PASS

N/A

N/A

Hitachi HDT725050VLAT80

VF4400R4D4HTUH

PURGED

PASS

N/A

N/A

This certificate will serve as record of compliant data eradication having
been performed on the drives listed above.
Figure 41 - Sample ‘Certificate of Compliance’
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Customizing Certificates of Compliance
To customize certificates of compliance, printed from the ‘Cert’ Tab, users may:
•

Create a custom Bitmap Image file (.bmp) to be used as the custom logo for
Certificates of Compliance.
o This should be placed in C:\Documents and Settings\<user>\My
Documents\CPR Tools Utilities Suite\Images\
o Name this bitmap image file certlogo.bmp.

The “Print Labels” Tab – CPR Toolbox™ Reporting
(Requires: Optional Bluetooth Printer)

The 'Print Labels' tab is not used when working with Sledge Hammer™.
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The “Log” Tab – CPR Toolbox™ Reporting

Figure 42 - Log Tab

The ‘Log’ tab displays a log of the most recent action Hammer™ has completed.
In the example shown in Figure 42, two (2) drives have been subjected to eradication using
NIST 800-00 ‘Clear’. The information shown in the Device Log screen includes information
about each drive as well as the start time and elapsed time:
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The “Alert Settings” Tab – CPR Toolbox™ Reporting

Figure 43 - Alert Settings Tab

The Alert Settings tab provides a method for email
alerts to be issued at pre-defined periods during a an
action performed by any CPR Tools’ device (PSIClone™,
Hammer™, SCSI Hammer™, etc…).
This version of CPR Toolbox™ allows for the
configuration of alert settings for devices not currently
attached to the host PC.

CPR Toolbox™ Notes:
The ability to send email alerts
requires an underlying connection to
the internet, usually through a
network to which the host PC running
CPR Toolbox™ is connected. If no
internet connection is present,
sending of alert emails will fail.

Begin by either selecting a currently connected device
from the ‘Selected Device’ drop-down list or by clicking
the ‘Add Device’ button to configure Alert Settings for a device not currently connected.
This is discussed in the section titled Alert Settings for Devices not currently connected
beginning on page 56 of this guide.
Figure 44 depicts the currently
connected Hammer™ as the
selected device.

Figure 44 - Working with a connected CPR Tools' device
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To instruct CPR Toolbox™ to send alert emails, check the box labeled ‘Enable Email Alerts’
and provide information in the fields named:
•

•
•

Sender
o A valid email address which will serve as the ‘from’ address for the alert being
sent.
Recipient
o A valid email address to which the alerts will be sent.
Server Name
o The mail server to be used for sending (SMTP).

Figure 45 shows the Email Configuration section of the Alert Settings tab.

Figure 45 - Email Configuration
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Figure 46 shows the Email Configuration section filled out with sample data.

Figure 46 - Email Configuration, sample data shown

If the outbound server requires authentication,
check the box marked ‘Authentication Required’
which will cause CPR Toolbox™ to request the
required login credentials as shown in Figure 47.

CPR Tools recommends testing all new email alert
configurations. This may be accomplished by
clicking the ‘Test Settings’ button after completing
the fields above. Clicking ‘Test Settings’ will
attempt to send a test email using the information
provided. If the information entered is sufficient to
send an email successfully, CPR Toolbox™ provides
a confirmation dialog and sends a test email to the
recipient.

Figure 47 - Enter Login Credentials, if
required

The confirmation dialog is displayed in Figure 48.

Figure 48 - Email Test is Successful
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Successful sending of the test email should result in the destination/recipient address’
receipt of an email similar to the one depicted here:
Email settings test email.
Sender: lab1@cprtools.net
Recipient: technician.dan@cprtools.net
Server: mail.cprtools.net
The right side of the Alert Settings tab provides configuration options which are used to
determine when Email Alerts are sent by CPR Toolbox™. This is shown in Figure 49.

Figure 49 - Alert Settings Configuration

To be alerted by email upon the ‘start’ of a Hammer™/CPR Toolbox™ operation, check the
box marked ‘Alert on Start’
To instruct CPR Toolbox™ to send email alerts at regular intervals during a Hammer™/CPR
Toolbox™ operation, check the box marked ‘Incremental Alerts’ and set either a value in
minutes or percentage complete for the period at which email alerts will be sent.
To receive email alerts when Hammer™/CPR Toolbox™ receive errors during an operation,
check the box marked ‘Alert on Error’ and select from ‘First’, ‘All’ or select a value for how
many errors should be encountered before Hammer™/CPR Toolbox™ sends an alert.
To be alerted when the operation is complete, check the box marked ‘Alert on End’.
The alert settings created are tied to the device listed in the ‘Selected Device’ list. This
version of CPR Toolbox™ allows for the creation of custom alert settings for CPR Tools’
devices which are not currently connected to the host PC running CPR Toolbox™.
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Alert Settings for Devices not currently connected
To begin configuring custom alert settings for a CPR Tools device not currently connected to
the host PC running CPR Toolbox, click the ‘Add Device’ button.

Figure 50 - The 'Add Device' button

CPR Toolbox™ will respond by presenting the ‘Enter
Device Information’ dialog box, as depicted in Figure
51.
Select a CPR Tools’ device type from the drop-down
list. Types of devices include:
•
•
•
•

PSIClone
Hammer
SCSI Hammer
Sledge Hammer Control Box

Figure 51 - Enter Device Information

Once a device type has been selected, enter the
device serial number in the field labeled ‘Device
Serial’. Once this information has been added, click
the button marked ‘OK’ to save the manually added
device in CPR Toolbox™.
Users may now configure alert settings by following
the steps shown, beginning on page 54 of this guide.
When the described device is connected, the settings created will automatically be enabled.
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Best Practice Recommendations
Organizations using CPR Tools’ data eradication devices should adhere to any regulations,
laws or rule sets which apply to their handling of end-of-life data.
By understanding the result codes and how they should be interpreted, IT managers and
those responsible for eradication management may make informed decisions in the physical
handling of these hard drives.
Figure 52 offers a matrix of operations, results and recommended actions which CPR Tools
considers ‘Best Practice’ handling of drives subjected to data eradication using the
Hammer™ line of data eradication products. These guidelines are a direct result of the data
recovery expertise gained over decades and the wealth of knowledge of hard drives and
their inner workings developed by CPR Tools engineers and technicians.
Operation(s)
Performed
SECURITY ERASE
WITH FULL
VERIFY
SECURITY ERASE
WITH QUICK
VERIFY
SECURITY ERASE
WITH NO VERIFY
BANG
WITH FULL
VERIFY
BANG
WITH QUICK
VERIFY
BANG
WITH NO VERIFY

Erasure
Result
PASS
PASS
FAIL

Verify
Result
PASS
FAIL
N/A

PASS
PASS
FAIL

PASS
FAIL
N/A

PASS
FAIL
PASS
PASS
FAIL

N/A
N/A
PASS
FAIL
N/A

PASS
PASS
FAIL

PASS
FAIL
N/A

PASS
FAIL

N/A
N/A

Recommendation
Safe for disposal.
Retry operation or degauss and physically destroy.
Retry operation or degauss and physically destroy.
Not fully verified, sensitivity of data must be
considered before disposal.
Retry operation or degauss and physically destroy.
Retry operation or degauss and physically destroy.
Not verified, sensitivity of data must be considered
before disposal.
Retry operation or degauss and physically destroy.
Safe for disposal.
Retry verify or degauss and physically destroy.
Retry operation or degauss and physically destroy.
Not fully verified, sensitivity of data must be
considered before disposal.
Retry verify or degauss and physically destroy.
Retry operation or degauss and physically destroy.
Not verified, sensitivity of data must be considered
before disposal.
Retry operation or degauss and physically destroy.

NIST-800-88 Compliance
PURGE
N/A
N/A
PURGE
N/A
N/A
PURGE
N/A
CLEAR
N/A
N/A
CLEAR
N/A
N/A
CLEAR
N/A

Figure 52 - CPR Tools 'Best Practice' recommendations
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Customization
Customizing the Look and Feel of CPR Toolbox™
The default logo presented in the main CPR Toolbox window can be customized. To add a
custom logo to CPR Toolbox:
1. Create a Bitmap Image file (.bmp) to be used as the custom logo/background
image
2. Place your image in C:\Documents and Settings\<user>\My Documents\CPR
Tools Utilities Suite\Images
3. Name this file backlogo.bmp
4. Close and restart CPR Toolbox. Your new logo will appear as the main window
background.
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Using CPR Toolbox™ with Multiple CPR Devices
CPR Toolbox™ was designed to simplify working
with CPR Devices (PSIClone™, Hammer™, etc…).
One key feature of CPR Toolbox™ is the ability to
work with multiple CPR Devices at the same
time.

CPR Toolbox™ Tips:
Use CPR Toolbox™ to manage and control
multiple CPR Devices. Commands issued
run concurrently; this saves time and
increases productivity.

CPR Toolbox™ displays all connected devices
(and the drives connected to them) in the
horizontal pane at the left of the screen, as shown below.

Figure 53 - CPR Toolbox™ controlling multiple CPR Devices

A key feature of using CPR Toolbox™ to control multiple devices is the ability to perform
actions simultaneously.
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Figure 53 and Figure 54 depict CPR Toolbox™ with two (2) CPR Devices attached.
Hammer™ Device (S/N 100488) is displayed performing an erasure.

Figure 54 - CPR Toolbox™ with multiple CPR Devices
Hammer (S/N 100488) shown performing an erasure

Figure 54 clearly shows an erasure being performed by the Hammer™ device shown in the
middle of the left horizontal pane. This is able to be determined by the red circle which
highlights the Hammer™ icon in the left vertical pane.

CPR Toolbox™ Tips:
When selecting a CPR Tools device (PSIClone™,
Hammer™, etc…) using CPR Toolbox™, the backlit
LCD of the device will become illuminated to assist
in identifying which device is the foreground
device in the CPR Toolbox™ view.
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Product Specifications
CHARACTERISTIC
Drive Interfaces:

SPECIFICATION
SATA Sledge Hammer™: SATA (8)
PATA Sledge Hammer™: PATA (8)

Max Transfer Rate:
Internal Power Supply:
Input Voltage :
Input Current:

Up to 6.0 Gigabytes per minute (UDMA 6)
300W
120 - 240V A/C • 50 or 60 Hz
Max: 6A A/C

Voltage Supplied to Drives:

+12VDC, +5VDC

Device Addressing Support:

32 bit and 64 bit

Operating Temperature Range:

0o to 50o Celsius

Storage Temperature Range:
Operating/Storage Humidity Range:
Approx. Dimensions:
Approx. Device Weight:

-20o to 60o Celsius
5% to 95% (non-condensing)
21.25” L x 3” H x 4.75” W
7 lbs.
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Customer Support
For more information, please visit us on the World Wide Web at http://www.cprtools.net/.
Visit http://www.cprtools.net for our complete offering of hardware and software for data
recovery and data security including:
PSIClone™
o CPR Tools’ flagship data recovery product. A fully functional, hand-held data
recovery solution.
Hammer™
o CPR Tools' flagship data eradication device. Hammer™ completely eradicates
data from SATA and PATA drives in compliance with NIST 800-88 'clear' and
'purge' specifications.
SCSI Hammer™
o SCSI Hammer™ completely eradicates data from SCSI drives in compliance
with NIST 800-88 'clear' and 'purge' specifications. SCSI Hammer™ is
capable of eradicating data from up to thirty (30) drives at once, when
working with external arrays or server backplanes.
HDD Adapters
o A full suite of sturdy adapters to simplify working with a variety of form
factors.
Head Combs
o Pre-fabricated head loaders; a must for hardware based data recovery efforts.
BangDisk32™
o HDD Sanitizing utility for Microsoft Windows.
AlarmDisk™
o Windows based system monitor, provides alerts to unauthorized HDD access.
Product specifications, user’s guides and more are available at
http://downloads.cprtools.net.
Technical Support for all CPR Tools products is available online at http://tickets.cprtools.net.
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